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Abstract

The Caenorhabditis elegans embryo is well suited for analysis of directed cell rearrangement 

via modern microscopy, due to its simple organization, short generation time, transparency, 

invariant lineage, and the ability to generate engineered embryos expressing various fluorescent 

proteins. This chapter provides an overview of routine microscopy techniques for imaging dorsal 

intercalation, a convergent extension-like morphogenetic movement in the embryonic epidermis of 

C. elegans, including making agar mounts, low-cost four-dimensional (4D) Nomarski microscopy, 

laser microsurgery, and 4D fluorescence microscopy using actin and junctional fusion proteins, as 

well as tissue-specific promoters useful for studying dorsal intercalation.

I. Introduction

Caenorhabditis elegans has several advantages that make it well suited for analyzing 

morphogenesis of living embryos. Its simplicity, transparency, and essentially invariant 

development enabled the determination of the complete embryonic cell lineage (Sulston 

et al., 1983). Such invariant development allows the assessment of mutant phenotypes at 

the level of single cells. The wild-type embryonic lineage was originally determined by 

direct observation using Nomarski microscopy. This was a very slow process, since only 

one or two of the >500 total embryonic cells could be followed per embryo. The advent of 

four-dimensional (4D) microscopy made analysis of morphogenesis much more practical by 

using computer-controlled equipment to record development of embryos in three dimensions 

over time (Thomas et al., 1996), which was exploited for lineage analysis (Schnabel et al., 

1997). More recently, the use of histone::GFP and other technologies, along with automated 

analysis, has streamlined lineaging even further. These developments have been discussed 

elsewhere (Murray et al., 2008; Wang et al., 2019).

The fundamental concepts of microscopy that apply to any context in C. elegans have been 

ably covered elsewhere, e.g., see (Maddox and Maddox, 2012). This chapter focuses on the 
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uses of modern microscopy specifically for imaging cell rearrangement in the C. elegans 
embryonic epidermis. This movement, known as dorsal intercalation, involves a highly 

directional interdigitation of twenty cells that initially form two rows that straddle the dorsal 

midline. The two rows of ten cells intercalate to form a single row. In the posterior the 

pattern of interdigitation is strictly alternating in normal embryos ((Walck-Shannon et al., 

2015; Williams-Masson et al., 1998); Figure 1).

We describe preparation of standard agar mounts and other approaches for immobilizing 

embryos for routine 4D microscopy, discuss simple methods for capturing 4D movies, and 

discuss various probes for imaging fluorescently tagged cells or structures in living embryos 

during dorsal intercalation and analyzing 4D data captures using these probes. We also 

describe the use of laser killing of blastomeres to study cell lineages that contribute to dorsal 

intercalation.

For historical reasons, the C. elegans epidermis has often been referred to as the 

“hypodermis”. Because the terms “hypodermal” and “epidermal” are used interchangeably, 

this chapter will use the latter for better consistency with standard usage in other organisms 

(see (Chisholm and Hardin, 2005) for discussion).

II. Methods

A. Mounting Embryos for Imaging of Cell Rearrangement

1. Agar Mounts for Imaging Morphogenesis; modified from (Hardin, 2011)—
The agar mount is a simple way to prepare C. elegans embryos for microscopy. For many 

morphogenetic events, especially those involving the embryonic epidermis, such mounts are 

extremely useful (see (Chisholm and Hardin, 2005; Vuong-Brender et al., 2016) for details 

of the basic movements associated with epidermal morphogenesis). Agar mounts have 

several key advantages for analyzing morphogenesis. First, the mount slightly compresses 

the embryo, holding it in place. Second, such compression produces a consistent orientation 

convenient for imaging many aspects of embryonic morphogenesis. As the processes of 

morphogenesis proceed, either the dorsal or ventral surface of the embryo will lie against 

the coverslip, which conveniently places the dorsal epidermis at the surface of the mount for 

high-resolution imaging using high numerical aperture oil immersion objectives in roughly 

half of the embryos so mounted. After ventral enclosure is complete, embryos turn on 

their sides, such that every embryo is positioned with either its right or left side facing the 

coverslip. For some events, other orientations of the embryo may be preferable, and for these 

purposes, other mounting techniques may be used (see below).

Imaging setup—For assembling the mount, a standard stereomicroscope is required. To 

identify early embryos without eye strain (1–4 cell), a total zoom of 80 or greater is 

recommended. We have typically used either a Wild MZ5 microscope with 20 oculars or 

Leica MZ12.5 microscope with 16 oculars.
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Materials

i. Reagents

Agar (5% w/v) M9 buffer:

3 g KH2PO4

6 g Na2HPO4

5 g NaCl

1 mL 1 M MgSO4

1 L H2O

VALAP:

Equal parts by volume of vaseline, lanolin, and paraffin. Heat thoroughly until melted 

and mix.

ii. Equipment:

Calibrated glass pipettes (50 μL)

Coverslips (18 × 18 mm, No. 1)

Eyelash brush (eyelash glued to end of round toothpick)

Mouth pipette 15” aspirator tube assembly

Microscope slides (25 × 75 1 mm)

Platinum wire pick: 2.5 cm of 30-gauge platinum or 90% platinum/10% iridium wire 

inserted into a 6” Pasteur pipette and heated in a flame until the glass melts around 

the wire. Flat-end hobby pliers or a small tack hammer can be used to flatten the end 

of the pick. Single-depression microscope slide (3 mm)

Syringes (1 cc) with 27-gauge ½” needles

Method

i. Use platinum wire pick to move approximately five gravid C. elegans 

hermaphrodites from culture dish to single-depression microscope slide 

containing M9 buffer. The number of hermaphrodites needed will depend on 

several factors, including the number of embryos of an appropriate age desired 

and the gravidity of the worms being used.

ii. Holding one syringe and needle in each hand, place one on either side of a 

hermaphrodite and draw flat sides of tips of needles across each other to cut 

the worm in half transversely. The embryos will be released from the halves 

of the hermaphrodite. Use eyelash brush to carefully prod halves to expel any 

remaining embryos. It is important to cut as close to the vulva as possible to 

release newly fertilized embryos in the uterus. This step can also be conducted 

by cutting the worm in half with a #15 curved blade scalpel (Fig. 1).
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iii. Sort embryos using eyelash brush and brush together into group of 

approximately ten embryos. Embryos will tend to stick slightly to each other 

when grouped. If one desires a certain stage of embryogenesis, it is at this point 

that embryo stage should be assessed and sorted appropriately. Two-cell stage 

embryos are the easiest developmental stage to collect.

iv. Using colored laboratory label tape, tape two microscope slides parallel and one 

slide width apart on the laboratory bench. Place a third slide between the two 

taped slides. Using a 6” Pasteur pipette, place three to four drops of molten 5% 

agar onto the middle slide. Immediately lay fourth slide perpendicular to other 

three slides over agar and press over taped slides to flatten agar before it cools.

v. Once agar has set up, use a razor blade to trim excess agar from edges of 

the slides. Solidified agar in the slide “sandwich” can be left assembled until 

embryos are ready to be added to the pad. Carefully slide the untaped slides apart 

so agar pad is left in center of one slide.

vi. Heat glass 50 μL pipette in flame. Once glass is soft and fluid, remove from 

flame and quickly pull apart ends. Break two ends apart to create a pipette with 

a tapered end with a diameter of approximately 40 μm. Place pipette in mouth 

pipette aspirator.

vii. When ready, carefully slide the untaped slides apart so agar pad is left in the 

center of one slide. Using mouth pipette, transfer the grouping of embryos (from 

step iii) and approximately 20 μL of M9 to the corner of agar pad on the 

microscope slide.

viii. Brush embryos out of M9 into the center of slide using eyelash. Position 

embryos in a single layer side-by-side. We find that especially in the case 

of embryos in which only a percentage show a phenotype of interest (e.g., 

homozygous mutant progeny from heterozygous mutant mothers, weak RNAi, 

etc.), that a large contiguous grouping of embryos is useful (Fig. 1H).

ix. Set the edge of a coverslip at the side of the agar 

padoppositetheM9andslowlydrop so that the coverslip lands on the embryos prior 

to the M9. Use a Kimwipe to wick excess buffer from edges of coverslip and 

wick air bubbles from under coverslip.

x. Trim excess agar from edges of coverslip using a razor blade. Seal edges of the 

coverslip with melted VALAP using a paintbrush.

Troubleshooting

i. Problem: Embryos fail to develop.

Solution: One-cell embryos are especially vulnerable to mechanical stress 

and are challenging to mount without killing. If studying a later stage of 

development, the likelihood of embryos surviving is markedly increased if two-

cell or later-stage embryos are used to make the mount. Groupings larger than 

15–20 embryos often display increased lethality due to oxygen starvation. By 
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keeping groupings of embryos to less than 20 embryos, oxygen starvation should 

not be a problem.

ii. Problem: The agar pad dries on the slide before it can be used.

Solution: Make the pad immediately before use. Stereomicroscopes with light 

sources mounted under the stage have the potential to heat the stage after long 

use, which can quickly dry agar pads. Using a stereomicroscope with an external 

bulb or a cool temperature bulb will reduce this problem.

iii. Problem: When coverslip is placed on slide, all the embryos wash to the edge of 

the coverslip.

Solution: Too much M9 buffer is used and the M9 buffer is hitting the embryos 

before the coverslip can land on them and hold them in the agar.

iv. Problem: The slide has air bubbles under the coverslip.

Solution: Use more M9 buffer. This will allow M9 buffer to completely wash 

under coverslip. However, too much M9 buffer will cause embryos to wash away 

(see previous Problem).

Discussion—Mounting C. elegans embryos on agar mounts provides a stable, long-term 

environment for microscopic analysis of development. The slight compression from the 

coverslip results in embryos reproducibly positioned with either the left or right side facing 

the objective lens. During later stages of embryogenesis embryos turn such that left-hand 

views become dorsal views and right-side views become ventral views. Embryos on agar 

mounts will survive and hatch from the eggshell on the mount. Embryos prepared with an 

agar mount are amenable to both light microscopy (with differential interference contrast 

optics) or confocal microscopy. Preparing C. elegans embryos on an agar mount is a simple 

technique that can easily be mastered and is regularly done by undergraduates. It provides a 

consistent embryonic orientation and environment that is suitable for long-term microscopy 

of C. elegans embryos.

2. Other Mounting Methods

For many morphogenetic events, agar mounts are convenient because they produce 

uniform orientation of developing embryos. However, there may be times when more 

randomized orientations are desired. Examples include imaging of the extreme posterior 

dorsal epidermis. For these cases, other mounts are more useful. We discuss two types here. 

Because protocols for producing these mounts are published elsewhere, we only briefly 

mention them here.

a. Simple poly-L-lysine mount (see (Mohler and Isaacson, 2010) for further 

details): The simplest approach is to mouth pipette embryos in random 

orientations onto a poly-L-lysine coated coverslip supported by grease feet above 

a microscope slide.

i. Spread a small volume of a 1 mg/mL stock of poly-L-lysine onto 

coverslips. Allow the coverslips to air-dry for >1 h. Poly-L-lysine is 
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typically applied from a premixed stock solution in distilled water 

(Sigma). Frozen stocks can be aliquoted and stored at 20°C indefinitely. 

Avoid refreezing.

ii. Cut gravid hermaphrodites at the vulva in M9. Mouth pipette embryos 

in a small volume (approx. 3 μL) of water onto precoated coverslips.

iii. Pipette a ring of silicon oil around the drop, and four dots of silicon 

vacuum grease (Dow Corning) to the corners of the coverslip. It is 

typically convenient to insert vacuum grease into a 10 mL plastic 

syringe without needle, from which it can then be extruded. The grease 

“feet” provide a spacer that allows a microscope slide to be affixed to 

the coverslip.

iv. Invert a slide over the coverslip to form the mount. Press gently to allow 

fluid to contact the slide.

b. Liquid mount with bead spacer (see (Murray et al., 2006) for further details): 

As an alternative to the simple poly-L-lysine mount method, polymer beads are 

added to the medium to serve as spacers between the coverslip and the slide to 

prevent the embryo from being excessively compressed. If the bead diameter is 

<25 μm (e.g., 20 μm), then this will result in slight compression of the embryos 

and results similar to the standard Agar mount. If larger diameter beads are used 

(e.g., 30 μm), then poly-L-lysine should be used as above.

i. Prepare a 1:30 dilution of 20 μm polymer beads (Polysciences, Inc., 

Warrington, PA) mixed with M9 in a microfuge tube.

ii. The bead mixture should then be resuspended with a pipette tip prior to 

use and added to the coverslip as above. Embryos can then be pipetted 

into the drop of bead slurry.

iii. No grease feet are needed using this method. Instead, seal the edges as 

described above for the standard agar mount, using Valap.

B. 4D Nomarski Imaging of Morphogenesis

Introduction—Acquisition of stacks of images throughout the thickness of the embryo 

over time is a crucial method for identifying the positions and contacts between cells. Such 

“four-dimensional” (4D) microscopy is a routine tool in laboratories that study early C. 
elegans development.

Imaging Setup

i. Microscopy/camera hardware: This protocol assumes a basic high numerical 

aperture (NA) microscope equipped with oil immersion objectives and, 

optionally, an oilable, high NA condenser from any of the major microscope 

manufacturers. We typically acquire 4D movies using a 60–63, 1.4–1.45 N.A. 

PlanApo objective. We have successfully used digital cameras from Scion 

Corporation and QImaging Corporation. The mounting hardware and cabling 
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interface for such devices differs depending on the microscope being used, 

although most cameras today use high-speed USB interfaces.

ii. Cooled environment: We have found that C. elegans embryos can be imaged for 

long periods of time if the ambient temperature is reduced to approximately 20° 

C.

iii. Z-axis and XY-axial controller(s)/shutter/serial port: A variety of Z-axis 

controllers are available from commercial sources (e.g., Prior, Ludl, ASI). These 

controllers have dial-based positioners that allows fine focus control. If an XY 

stage option has been purchased, the XY stage is typically controlled using a 

joystick that can be set for coarse (rapid) movement or fine (slow) movement. 

This allows for 5D acquisition, i.e., automated movements to a group of embryos 

at a particular XY position on the stage, followed by acquisition of a Z stack at 

that position. This approach allows for more embryos in a single experiment to 

be imaged. In addition, a shutter to block the transmitted light path between time 

points is strongly encouraged to minimize exposure of embryos to light and heat. 

A number of shutters are available. We have used shutters from Ludl and Vincent 

Associates.

iv. Software: Many commercial software packages can be used to acquire 4D 

footage. If an inexpensive alternative is desired, we strongly favor the public 

domain program Micro-Manager, which is built on top of ImageJ, supports 

a variety of CCD cameras, Z motors, and shutters, and, with some effort, 

novices can extend its functionality using the Beanshell scripting language or 

through the Java plugin architecture supported by ImageJ. Micro-Manager has 

a major advantage over other free alternatives, in that it is being continuously 

updated to support new hardware. The Micro-Manager program can be 

obtained at the following URL: https://micro-manager.org. The remainder of 

this section will describe the basic use of Micro-Manager to acquire 4D data. It 

assumes successful handshaking between Micro-Manager and hardware. Details 

regarding creating a hardware configuration file for a particular setup can be 

found on the Micro-Manager web site (https://micro-manager.org/wiki/Micro-

Manager_Configuration_Guide).

Methods

i. Setting up a 4D (or 5D) acquisition sequence

a. Turn on the Z-axis and shutter control boxes and the CCD camera. Turn 

on the light switch on the microscope. Find a group of embryos using 

the 10x objective, prior to oiling the coverslip.

b. If a high NA condenser is present, place a drop of oil on the 

condenser (for upright microscopes) or the bottom of the slide (inverted 

microscopes). Carefully position the condenser so that it contacts the oil 

and spreads it uniformly between the condenser and microscope slide.
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c. Focus the condenser. The simplest method for achieving good 

condenser focus is to stop down the condenser using the iris diaphragm, 

closing it almost completely. Then the height of the condenser can 

be adjusted at high magnification until the octagonal outline of the 

diaphragm is in focus. When done, open the condenser.

d. Once embryos have been located at 10x and the condenser has been 

focused, swing the 10x objective out of the way and add a drop of 

immersion oil to the coverslip (upright microscope) or the 60x objective 

lens (inverted microscope). We find that Type DF oil works well.

e. Carefully slide the 60x or 100x objective into place (it should just clear 

the sealant on the slide, as long as it is not too thick). Make sure the 

correct condenser setting is selected to match the lens.

f. Refocus on the embryos and refocus the condenser.

g. Open Micro-Manager. Use the “Live” button in the main Micro-

Manager Studio window to display an image from the camera. If 

the “Autoshutter” option is not checked, click the “Open” button to 

open the shutter. Otherwise it should open when the “Live” button is 

clicked. Optimize the positioning of embryos in the field using the stage 

controls on the microscope, and/or by rotating the CCD camera gently 

by hand (if the mount supports this). Optimize the Nomarski optics 

through a combination of the following:

i. Center the condenser by closing it and moving the octagon 

to the center of the field of view. Reopen the diaphragm to 

encompass the entire field of view.

ii. Adjust the light level. High-quality Nomarski optics requires 

a substantial amount of light. Optimal settings must be 

empirically determined.

iii. Adjust the exposure time, gain, and other settings on the CCD 

camera within Micro-Manager a final time if needed.

h. Invoke the Micro-Manager 4D acquisition system by selecting the 

“Multi D Acq.” In the main Micro-Manager window button (Figure 

2).

i. In the “Multi-Dimensional Acquisition” panel, enter the desired 

parameters for time interval, number of time points, number of focal 

planes, and distance between focal planes. If a shutter is being used, 

makes sure that the “Use shutter” option is selected. We typically use 

“relative Z” to allow adjustment of focal plane to accommodate slight 

drifting due to drying of the agar pad over time.

j. Enter the name prefix for the images that will be collected [Note: some 

older operating systems or hard drive formats still limit the total length 
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of a file’s name to 32 characters; we recommend keeping the root name 

short].

k. When prompted for a location to which to save images, make a new 

directory that will contain the images from the 4D sequence. Within 

the newly created directory, we recommend making two additional 

directories: (a) one called “working” and (b) one called “terminal.” The 

latter is useful for acquiring a final Z stack of the terminal embryos.

l. We typically use the “Separate image files” format, rather than “Image 

stack files”, in case for some reason the acquisition fails partway 

through.

m. Typical settings for a long overnight movie are the following:

Number of time points: usually 200–300 for an overnight movie

Time interval (s): usually 120–180

Number of shutters: 1

Number of focal planes: 20

Distance between focal planes: 1 μm

Root name: “working,” or a short name of choice

Information for movie: Enter any pertinent information.

n. If an XY stage is available, then the “Multiple positions (XY)” option 

can be checked. When the “edit position list” button is clicked, the 

Stage Position List panel will appear. Clumps of embryos can then be 

located. When centered in the field of view, the “Mark” button can be 

selected to generate a set of XY-coordinates. Click “Close” to return to 

the main Multi-D Acq panel.

o. When satisfied with the settings, click “OK.” The computer should start 

acquiring images. Status updates will be displayed in the ImageJ main 

window. To abort, click the “Stop” button in the “Script Panel” window. 

During acquisition previously acquired time points and their associate Z 

stacks can be viewed to check the acquisition.

p. When the movie is finished, we recommend collecting a terminal image 

stack. To do so, keep the field of view the same. Collect a second 

movie, specifying “1” as the number of time points. Save this movie in 

the “terminal” folder created previously.

ii. Viewing 4D/5D datasets: To view the movie, there are several options available.

a. Micro-Manager: Micro-Manager itself has an excellent 4D/5D playback 

interface.

b. Standard ImageJ or Fiji: If import into standard ImageJ or Fiji is 

preferred, one of us (JH) has written a simple plugin that automates 
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the creation of a Hyperstack from the Metadata.txt file of a Micro-

Manager dataset and loads into a Virtual HyperStack window in 

ImageJ 1.53c and later. This greatly reduces the memory overhead 

and time to import large datasets. This plugin can be accessed at http://

worms.zoology.wisc.edu/research/microscopy/4d.html

Troubleshooting

i. Problem: No light appears to be reaching the camera.

Solution: Make sure the slider that diverts light from the microscope to the 

camera port is in the proper position, and that the power supply to the camera is 

on. If the shutter has an external toggle switch, make sure that it is in the correct 

position. If the exposure time is set to too low a value, increase the exposure time 

using the controls in the main Micro-Manager window.

ii. Problem: The plane of focus drifts systematically over time.

Solution: This often occurs in the first few minutes after making an agar mount. 

For this reason, it is advisable to check the focus several times during the first 

15–20 min of acquisition. To reset the focus, open the shutter and use the coarse 

focus on the microscope to refocus on the top focal plane.

iii. Problem: Temperature variation in the room results in inconsistent time course of 

development or variable phenotypes.

Solution: For best results, filming should take place in a room held at constant 

temperature, approximately 20°C. Make sure the air conditioner is on and that 

the door remains closed.

iv. Problem: After several hundred time points Micro-Manager reports an error from 

which it cannot recover.

Solution: Some users have reported errors under Micro-Manager when using 

USB-to-serial port adapters. This is known issue with versions of Micro-

Manager prior to 1.4. Using a PCI-based serial port card appears to alleviate this 

problem in Windows 10. MacOS users must use serial port adapters. Because 

most camera drivers are Windows-only, we recommend using a basic Windows 

10 machine for acquisition. We routinely acquire dataset of hundreds of time 

points with 20–50 focal planes/time point. Alternatively, acquire several shorter 

movies.

Discussion—This procedure results in the production of 4D datasets in the form of a 

series of consecutively named TIFF files that can be read by many different programs, 

including ImageJ, especially when supplemented with appropriate plugins. The reduced 

costs of such a system, its cross-platform flexibility (ImageJ is supported under Windows, 

MacOS, and various Linux distributions) make this basic system feasible for teaching 

laboratories and research laboratories with limited funds. While we have described the use 

of such a setup for imaging C. elegans embryos, this apparatus is well suited to acquiring 

images of any transparent specimen.
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iii. Introducing Pharmacological Agents During 4D Acquisition (adapted from 

(Williams-Masson et al., 1997))

Introduction—This procedure assumes a fairly standard laser ablation setup. Many C. 
elegans laboratories use a nitrogen laser to pump a tunable dye laser routed through the 

epifluorescence light path of the microscope. The dye cuvette typically contains Coumarin 

440 dye, which can be obtained from Sigma or other suppliers, and is reconstituted in 

methanol at a concentration of 5 mM in methanol (see the protocol in (Walston and Hardin, 

2010) for further details). A common version of this setup is sold by Andor Corp., under 

the trade name Micropoint. It has been reported that some eggshell permeability-defective 

mutants can be used to introduced drugs (Olson et al., 2012), However, we have found that 

such embryos consistently display morphogenetic defects, making this approach less than 

optimal.

Methods

1. Creating the mount

a. Cut gravid hermaphrodites at the vulva in water. Mouth pipette embryos 

in a small volume (approx. 3 μL) of water onto coverslips precoated 

with 1 mg/ mL poly-L-lysine. Poly-L-lysine is typically applied from a 

premixed stock solution in distilled water (Sigma).

b. Allow embryos to settle for 30 s and then treat for 2 min with 100 μg of 

FITC-conjugated poly-L-lysine (Sigma). FITC-poly-L-lysine enhances 

absorption of 440nm laser light by the eggshell.

c. Rinse embryos three times with embryonic growth medium (EGM; 

for a detailed recipe, see Shelton and Bowerman, 1996) + 3 μg/mL 

Nile Blue A (Sigma) + 1–2 μg/mL cytochalasin D or nocodazole. 

The addition of Nile blue allows the assessment of perforation of the 

eggshell; permeabilized embryos will take up the dye into granules in 

gut cells.

d. Cover with a 30 μL drop of EGM plus drug. Stock solutions of 2 μg/mL 

cytochalasin D or nocodazole (Sigma) in DMSO can be stored at 4°C.

e. Pipette a ring of silicon oil around the drop, and four dots of silicon 

vacuum grease (Dow Corning) to the corners of the coverslip. It is 

typically convenient to insert vacuum grease into a 10 mL plastic 

syringe without needle, from which it can then be extruded. The grease 

“feet” provide a removable spacer that allows a microscope slide to be 

affixed to the coverslip.

f. Invert a slide over the coverslip to form the mount. Press gently to allow 

fluid to contact the slide.

2. Perforating the eggshell
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a. Determine the position of the ablation beam by moving to a region 

of the mount away from the embryos. Focus on the coverslip, and 

crack the coverslip using the laser. In the case of the standard manual 

Micropoint laser, a sliding neutral density grating can be used to 

attenuate the beam strength. Beam amplitude should be just sufficient to 

crack the coverslip. If more power is desired later, then the grating can 

be adjusted accordingly.

b. Select an embryo of the desired developmental stage. Find a region of 

the embryo where there is a space between the cells and the eggshell. 

Embryos are typically oriented within the eggshell such that there is a 

larger space between the anterior end of the embryo and the eggshell 

than in other regions of the embryo, making this region convenient for 

laser irradiation.

c. Position the embryo so that the eggshell of this region is over where the 

ablation laser will hit.

d. Using a foot pedal or push button, pulse the laser. Usually only one hit 

is necessary, but sometimes more pulses are required.

e. It is often possible to tell that the eggshell is perforated because the 

embryo will move slightly toward the perforation site. However, we 

have found that sufficiently small holes will not induce this response, 

yet dye penetration will nevertheless be observed.

f. If needed, additional perforations can be induced to increase the rate 

of penetration of the compound of interest. However, we have found 

that the number of viable embryos obtained in these cases goes down 

markedly.

g. These mounts can be imaged using 4D microscopy. We have also found 

it possible to remove the coverslip and process embryos for phalloidin 

staining (see above; for examples, see references).

h. Embryos can be scored after 4 h for blue gut granules, which 

indicate that sufficient permeabilization was achieved for Nile Blue A 

penetration.

Discussion—Performing long-term 4D filming after perforation of the eggshell is 

difficult. Many embryos show abnormalities in subsequent development. Extensive negative 

controls (i.e., perforation of the eggshell in the presence of carrier, such as DMSO, alone) 

are therefore highly advisable. If sufficient precautions are taken, however, it is possible to 

perform pharmacological inhibition followed by 4D filming (Thomas-Virnig et al., 2004; 

Williams-Masson et al., 1998).

iii. Creating colorized overlays on 4D Nomarski movies

Introduction: It is often valuable for presentation purposes to colorize single cells from 

Nomarski 4D datasets. This is particularly valuable for dorsal intercalation, in which 
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colorizing makes it intuitively obvious which cells show abnormal position (see Figure 

1). Unlike fluorescence micrographs, for which segmentation algorithms exist that allow 

semi-automated boundary tracing, there is currently no substitute for manual tracing of 

cells in Nomarski movies. Commercial packages, such as Adobe After Effects are powerful 

for this purpose, and allow “tweening” of regions of interest and editable outlines, but are 

expensive. Here we present a simple method for outlining cells in Nomarski movies using 

the freeware package ImageJ/Fiji.

Method

1. Import image sequence: Import an image sequence into ImageJ or Fiji 

using the “File-> Import->Image Sequence…” command. Before the image is 

pseudocolored, it should be cropped and rotated into the desired orientation. 

The cropped and rotated image sequence should be saved as an image sequence 

distinguishing it as the unaltered, cropped and rotated movie.

2. Draw overlays:

a. Draw selections

i. To draw overlays, begin with the first frame. Either the 

“Freehand selection” or “Polygon selection” tool may be used 

to trace the cells that are to be pseudocolored. For dorsal 

intercalation, we typically pseudocolor the six posterior cells 

in the dorsal array, which display an invariant, alternating 

pattern of intercalation (Williams-Masson et al., 1998).

ii. Add the first overlay to the ROI manager: Once an overlay 

selection has been drawn, it can be added to the ROI 

manager by selecting Image->Overlay->Add Selection from 

the toolbar. The ROI manager can be opened by selecting 

Image->Overlay->To ROI Manager. With the ROI Manager 

open, multiple selections can be added and manipulated 

simultaneously. Note: The numbers associated with each ROI 

can be removed from the ROIs by unticking the “Labels” box 

in the ROI manager.

iii. Add additional overlays on the first image: To add another 

ROI, draw another selection and select “Add” in the ROI 

Manager.

iv. Modify overlay properties: With one or more ROIs selected 

in the ROI Manager, clicking “Properties” will allow fill and 

stroke color to be modified. Within the Properties pop-up box 

it is possible to enter values for stroke color, stroke width, 

and fill color. For the cyan cells in the example in Figure 4, 

stroke color has been switched to “none” and the fill color 

is 20% opacity for cyan. Once the values are filled, clicking 

OK applies the changes. A hexadecimal color value chart is 
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often useful for consistency and allows both color selection 

and opacity value for overlays. See https://imagej.nih.gov/ij/

docs/guide/146-28.html#toc-Subsection-28.14

v. Flatten overlays: Once all of the ROIs for one time point 

are filled and labeled or unlabeled as desired, the overlays 

can be merged with the image by selecting “Flatten” in the 

ROI manager. The image will appear unchanged. However, the 

ROIs can now be deleted.

vi. Continue to additional time points and save image sequence: 

Continue to the second time point. Once all time points are 

modified with overlays, the image sequence can be saved in 

a new folder distinguishing it as the pseudocolored image 

sequence.

vii. Side-by-side presentation of unmarked and pseudocolored 

data: It is often desirable to present the unaltered image 

sequence and the pseudocolored image sequence side-by-side. 

With both Image sequences open, they can now be combined 

into one image sequence. Both image sequences must be the 

same type, size, and length. The type of image sequence can 

be checked and changed using the Image->Type-> command. 

This shows which type an image sequence is and allows the 

image sequence type to be changed. Selecting Image->Stacks-

>Tools->Combine combines the two image sequences into one 

image sequence in which the movies will play side-by-side.

viii. Concatenating unmarked and pseudocolored sequences: 

Alternatively, selecting Image->Stacks->Tools-> Concatenate 

merges the two image sequences into one image sequence in 

which they will play sequentially.

C. Fluorescence Imaging of Morphogenesis

1. General considerations for 4D Fluorescence Imaging of cell rearrangement: 
Nomarski microscopy, while a daily workhorse for imaging morphogenesis 

and performing basic phenotyping, is limited. Refractile elements in the 

cytoplasm of embryonic cells, combined with the inherent curvature of the 

embryo, limits the resolution of the standard Nomarski microscope. In addition, 

the dorsal epidermis is exceedingly thin (less than 0.5 μm in some cases), 

making it difficult to resolve. Fluorescence imaging of specific structures 

in embryos, combined with confocal or multiphoton microscopy, overcomes 

these challenges. (Maddox and Maddox, 2012) describe basic modalities of 

fluorescence microscopy. For long-term 4D acquisition in which many focal 

planes are acquired, laser scanning confocal microscopy (LSCM) quickly leads 

to arrest of embryos, and so it is not well suited to long-term viability of embryos 
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filmed over many hours. Fluorescence live-cell imaging modalities that we have 

found effective include the following:

a. Multiphoton excitation laser scanning microscopy (MPLSM): 

Multiphoton laser-scanning microscopy has several potential 

advantages over LSCM for live imaging of embryos. MPLSM excites 

fluorescence using a series of short, high-energy pulses of near-infrared 

photons from a mode-locked laser. MPLSM has a key advantage 

for live embryo imaging experiments in C. elegans. In a two-photon 

microscope the probability of excitation varies as the inverse fourth 

power of the distance from the focal plane. Photons are thus only 

absorbed in a very small volume centered on the plane of focus, 

eliminating photobleaching and photodamage caused by excitation 

of fluorophores above and below the plane of focus. The resulting 

improvements in viability can be quite dramatic. In our laboratory, C. 
elegans embryos expressing a GFP-tagged junctional proteins can be 

imaged for many hours using MPLSM. An example is shown in Fig. 3. 

Although MPLSM can be superior to LSCM for many applications, the 

typical MPLSM device is expensive and requires frequent alignment. 

Second, for fluorophores that emit in the red portion of the visible 

spectrum, the wavelengths needed to generate a two-photon event are 

longer than those produced by the Ti:Sapphire lasers commonly used in 

commercial MPLSM devices.

b. Disk-scanning and swept-field confocal microscopy: For the 

developmental biologist, spinning disk systems based on Yokagawa 

scanheads are an inexpensive alternative to MPLSM. Because disk-

scanning systems use an off the-shelf focus motor, CCD, filter 

wheel, and shutter components, commercial imaging packages or 

freeware packages such as Micro-Manager can be used to drive 

data acquisition. Others have used swept-field microcopy to rapidly 

acquire 4D fluorescence datasets (see (Maddox and Maddox, 2012)). 

In our laboratory, disk-scanning technology is used for routine 4D data 

acquisition during morphogenesis. The data generated by spinning disk 

or swept-field microscopy can also be improved via post-acquisition 

deconvolution, making its Z resolution comparable to LSCM or 

MPLSM.

c. Considerations for optimizing 4D data acquisition during 

morphogenesis: As with 4D Nomarski imaging, ambient temperature 

must be controlled carefully if one wishes to compare rate of migration 

or timing of developmental processes across datasets. The temperature 

must be kept below 25°C; for long films, a temperature closer to 20° 

C is advisable. This is often not possible in shared user facilities, in 

which elevated temperatures suited to tissue culture work are the focus. 

Second, despite theoretical calculations of voxel sampling in Z stacks 

of fluorescent images, it is typically advisable to acquire very closely 
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spaced optical sections if one is imaging events in the epidermis. We 

have found that focal planes spaced 0.5 μm apart or less are necessary, 

due to the extreme thinness of the epidermis. For very high-resolution 

filming of cytoskeletal elements or thin structures, we have found that 

very high NA lenses are helpful. In particular, we have found that lenses 

designed for total internal reflection microscopy (TIRF), but without 

the internal optics for TIRF itself, provide excellent results, such as 

recent vintage Nikon NA 1.45 oil immersion “TIRF” lenses.

2. Probes for Visualizing Morphogenesis: The discovery and widespread use of 

variants of genetically encoded fluorescent proteins (FPs) for visualizing gene 

expression and protein localization within living organisms revolutionized live 

embryo imaging, including in C. elegans.

a. Junctions: For studying morphogenetic movements in embryos, 

junction-localized FPs are extremely useful. These include AJM-1 

(Mohler et al., 1998), DLG-1 (Koppen et al., 2001), HMP-1/a-catenin 

(Raich et al., 1999) and HMR-1/cadherin (Achilleos et al., 2010). 

With the advent of CRISPR/Cas9 genome editing (Dickinson and 

Goldstein, 2016) many endogenously tagged versions of junctional 

protein have been produced, e.g., (Marston et al., 2016). The use of 

epithelial junctional markers is particularly useful for following cellular 

movements at single-cell resolution during events such as dorsal 

intercalation. The use of such markers provides much clearer views 

of morphogenetic movements than can be achieved with Nomarski 

microscopy (Figure 5).

b. Actin: We have employed two basic methods to visualize the F-actin 

cytoskeleton in embryos during morphogenesis: (i) phalloidin staining 

of fixed specimens and (ii) imaging of the F-actin binding fragment of 

the spectraplakin, VAB-10, fused to GFP (Gally et al., 2009). As an 

alternative to the latter, LifeAct strains, driven by epidermal promoters 

(Havrylenko et al., 2015), can also be useful. However, as described 

below, mosaic expression of transgenes is very useful for visualizing a 

subset of cells in the dorsal array, and so we prefer to use vab-10::gfp 
strains, which exhibit greater mosaicism.

i. Phalloidin staining for analyzing morphogenesis Reagents

Materials

Bleach Solutions

1. Bleach solution:

a. 0.4 mL bleach

b. 0.4 mL 10N KOH

c. 3.2 mL water
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2. Fix/permeabilization solution:

a. 200 mL 10% PFA

b. 10 mL 10% Triton X-100 (Sigma) or 5 mL 10 mg/mL lysolecithin in 

chloroform (Sigma).

Lysolecithin is much gentler than (and hence preferable to) Triton, and 

will preserve fine structure, but also results in less overall extraction, 

leading to higher background signal in some cases.

c. 48 mL 0.5 M PIPES (pH = 6.8)

d. 25 mL 0.5 M HEPES (pH = 6.8)

e. 1 mL 1 M MgCl2

f. 10 mL 0.5M EGTA

g. 196 mL ddH2O

3. Phalloidin solution:

a. 6 μL 6.6 mM Alexa-488

b. 114 mL 1 PBS

Other solutions:

1. 10% PFA

a. 1 g paraformaldehyde

b. 30 mL 5N NaOH

c. 10 mL 60 mM PIPES (1.2 mL 0.5M PIPES + 8.8 mL ddH2O)

Incubate 30 min in 65°C water bath until PFA is dissolved (note: do not 

exceed 65°C!)

2. 10% Triton

a. 1 mL Triton X-100

b. 9 mL ddH2O

Place on a nutator platform to mix thoroughly

3. 0.5 M PIPES

4. 0.5 M HEPES

5. 1 M MgCl2

a. Dissolve 203.3 g of MgCl2•6 H2O in 800 mL of dH2O. Adjust the 

volume to 1 L with dH2O.

Dispense into aliquots and sterilize by autoclaving or filtering.

Keep aliquots closed when they are not being used.
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6. 0.5M EGTA

a. Add 190.175 g ethylene glycol bis(beta-aminoethyl ether) N,N,N0,N0-

tetraacetic acid (EGTA) to 1 L of dH2O.Stir vigorously on a magnetic 

stirrer. Adjust the pH to 8.0 with NaOH. Dispense into aliquots and 

sterilize by either autoclaving or filtering.

7. 1 PBS

a. 137 mM NaCl

b. 2.7 mM KCl

c. 10 mM Na2HPO4

d. 2 mM KH2PO4

Dissolve 8 g NaCl, 0.2 g KCl, 1.44 g Na2HPO4, and 0.24 g KH2PO4 

in 800 mL dH2O. Adjust the pH to 7.4 with HCl. Add dH2O to 1 L. 

Autoclave to sterilize.

ii. Method

1. Make solutions and coat ring slides with 25 mL poly-

L-lysine.

2. Obtain eggs from adults by bleaching. Make sure 

to sweep embryos off the plate using a glass 

pipette. Hint: It is sometimes advantageous to bleach 

embryos for a slightly longer period of time to 

further weaken the eggshell. This can be done 

by allowing the embryos to remain in the bleach 

solution for another minute after the worm carcasses 

have all been dissolved.

3. Wash embryos at least 2 with ddH2O. We find they 

stick to the slide better when using water, not M9.

4. Add embryos to ring slides that have been precoated 

with poly-L-lysine. Let sit 5–10 min to give embryos 

time to adhere. Hint: It helps the embryos to adhere 

when the slide is rinsed with ddH2O before adding 

the embryos.

5. Remove the water from the ring slide. The bulk of 

the liquid can be poured off into a liquid waste 

container, if care is taken to avoid mixing embryos 

from one ring to another. Use a Kimwipe to gently 

remove the remaining liquid.

6. Add 45–60 μL of the fix/permeabilization solution to 

each ring.
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7. Incubate the slides for 20 min in a humid chamber 

at room temperature. If there are many embryos, it 

is advisable to incubate 2–5 min longer. A simple 

humid chamber can be made by placing wet paper 

towels in the bottom of a Tupperware container.

8. Wash slides 2x, 5 min each with 1x PBS by adding 

70 μL of PBS to each ring per wash. Remove liquid 

after each wash as above.

9. Add 60 mL phalloidin solution to each ring.

10. Incubate 1–2 h in a humid chamber at room 

temperature in the dark (we usually incubate for 

90 min). Alternatively, incubations can be carried 

out at 4°C overnight in the dark, which can reduce 

background.

11. Wash slides 2 × 5 min with 1x PBS while rotating.

12. Dry off slide using a Kimwipe. Mount by inverting 

an 18 mm square coverslip with 8 μL SlowFade over 

each sample. Seal edges with nail polish.

iii. VAB-10(ABD)::GFP: Phalloidin is obviously not suitable 

for capturing rapid, dynamic movements involving the actin 

cytoskeleton. A powerful approach for in vivo analysis of 

actin in living embryo exploits F-actin-binding proteins. 

Two that have been used during early development are 

moesin::GFP (Velarde et al., 2007) and Lifeact::GFP (Pohl 

and Bao, 2010). The atter has been cloned behind an 

epidermal promoter (Havrylenko et al., 2015). For the study 

of morphogenesis, the spectraplakin VAB-10, which contains 

both actin- and tubulin-binding motifs, was exploited by the 

Labouesse laboratory to produce a construct containing the 

actin-binding domain (ABD) of VAB-10 tagged with GFP or 

mCherry (Gally et al., 2009). We have used this construct 

to image protrusive dynamics during dorsal intercalation. Use 

of the VAB-10 constructs requires care; we have found that 

excessive imaging can lead to lethality in strains containing 

vab-10ABD transgenes. For short periods of time, however, 

these constructs are invaluable for imaging rapid actin 

dynamics. In addition, the original vab-10ABD strains are 

mosaically expressed. For reasons that are unclear, C-derived 

dorsal epidermal cells frequently exhibit mosaic expression 

(Figure 6), allowing imaging of a cohort of cells against a 

relatively dark background.
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c. Tubulin: Numerous antibodies can be used to visualize tubulin during 

morphogenesis, using standard freeze-cracking (Miller and Shakes, 

1995). Alternatively, there are several GFP constructs that have been 

successfully used to visualize epidermal cells. A particularly useful 

set of such constructs have recently been published that use the lbp-1 

promoter to drive expression of either tubulin subunits or plus-end 

tracking proteins predominantly in epidermal cells. These include 

Plbp-1::gfp::β-tubulin and Plbp-1::ebp-1/EB 1::gfp (Fridolfsson and 

Starr, 2010), which are especially useful for analyzing microtubule 

dynamics during dorsal intercalation.

d. Cell cortex/membranes: Several markers have been particularly useful 

for visualizing the cell cortex or membrane. These include a ced-10/
Rac::gfp translational fusion (Liu et al., 2007) and various PH-domain 

constructs fused to mCherry or GFP (e.g., (Audhya et al., 2005)).

e. Cytosolic markers: Fusing the coding region of eGFP to the 

regulatory DNA associated with a gene of interest (i.e., GFP “reporter 

constructs”) is used to assess the tissue-specific and temporal pattern 

of transcriptional activation of a gene. However, such transcriptional 

reporters can also be invaluable for live embryo imaging for several 

reasons. First, such reporter constructs result in the expression of GPF 

in the cytosol; because GFP is fairly small, these reporters are capable 

of percolating into small volumes within the cytoplasm, including fine 

protrusions extended by cells as they migrate. Second, the highly 

specific pattern of expression of some genes allows either many or a 

very small number of cells to be visualized against a dark background, 

dramatically improving the effective contrast of the specimen being 

imaged. Third, imaging cytosolic GFP reporters typically does not 

cause as much photodamage as with FP translational fusions. We have 

used two different markers to image events in the dorsal epidermis: 

Plbp-1::gfp (Heid et al., 2001) and Plat-1::gfp (Langenhan et al., 

2009). Examples are shown in Figure 7A,C. A useful adjunct to the 

use of cytosolic markers is the use of a voxel rendering program 

to generate three-dimensional representation of cells expressing such 

markers (Figure 7B).

f. Rho GTPase biosensors: The presence of activated Rho family GTPases 

can be detected using fragments of known effector proteins that 

preferentially bind the active forms of these GTPases. We have 

successfully used two biosensors.

i. Epidermal RHO-1/RhoA biosensor: a fragment of the protein 

ANI-1/anillin tagged with GFP has been shown to be useful as 

a Rho biosensor (Tse et al., 2012). We have cloned the coding 

region of this construct behind the lbp-1 promoter (E. Walck 

Shannon and J. Hardin, unpublished).
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ii. CDC-42 biosensor: a fragment of the WSP-1/WASP protein 

that binds active CDC-42 (Kumfer et al., 2010), driven by 

the endogenous wsp-1 promoter can be used as a biosensor 

for active CDC-42 (Walck-Shannon et al., 2016); Figure 8). 

Medial enrichment measures can be obtained by calculating 

the ratio of average intensity measurements at the medial and 

lateral edges of cells of interest in ImageJ/Fiji. Specifically, 

for each cell, the lasso tool can be used to manually select 

the medial cell edge, lateral cell edge, and a random area in 

the cytoplasm (non-nuclear), which serves as background. The 

average intensity of the background can then be subtracted 

from the medial and lateral edge measurements prior to 

calculating the fold enrichment in signal. We have used Z 

projections of 5 focal planes, spaced 0.4 μm apart, for this 

analysis.

3. Quantifying protrusive behavior during dorsal intercalation From (Walck-

Shannon et al., 2016; Walck-Shannon et al., 2015)

Introduction: We have used simple metrics to score phenotypic defects in dorsal epidermal 

cells during intercalation.

METHOD

a. Scoring of embryos for key dorsal intercalation phenotypes: Dorsal cells exhibit 

two main defects in motility, which we have termed (i) “medial delay” or 

“contralateral fightingm” and (ii) “ipsilateral comigration” (Walck-Shannon et 

al., 2015); Figure 9). Embryos scored as “contralateral fighting” have blunt 

medial edges for greater than 15 minutes. Embryos scored as “ipsilateral 

comigration” if at least one pair of two adjacent cells intercalate together across 

the dorsal array. If embryos exhibit both phenotypes, we typically score them as 

“contralateral fighting”, which is visible earlier.

b. Protrusion area, number, and position: We use ImageJ/Fiji for all measurements. 

To avoid confirmation bias in protrusion measurements, we define “protrusions” 

from maximum intensity Z projections of z-stacks of VAB-10::ABD::GFP 

reporter expression (typically 5 focal planes, spaced 0.4 μm apart).

i. Relative protrusion area: We calculate this metric as the ratio between 

a cell’s area in maximum projection images (which includes all 

protrusions) to the cell’s lateral area (measured at the depth of the cell’s 

nucleus).

ii. Protrusion number: We typically define a “protrusion” as any 

aggregation of F-actin reporter signal extending at least 0.5 μm from 

the cell body.

c. Protrusion length, position, and orientation: Protrusion length and position 

are recorded using the ROI tool in Image J. Angles can be obtained using 
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trigonometric functions in Microsoft Excel to compare protrusion position 

relative to the cell centroid (also calculated in ImageJ).

d. Tip measurements: For initial orientation measurements, tip angles can 

calculated using trigonometric functions as the angle of a line connecting the 

tip to the cell centroid. The cell centroid, nuclear center, and aspect ratios were 

measured in ImageJ from the manual outline of each cell/nucleus.

e. Angular statistics and Rose plots: There are several packages that can generate 

such analyses, including the Circular package in R. For many biologists, 

however, the R interface is challenging. We have found PAST (Hammer 

et al., 2001) to be less daunting for many biologists. PAST is available 

as a cross-platform application from https://www.nhm.uio.no/english/research/

infrastructure/past/.

D. Inducible expression of Rho family GTPase constructs using the NMD system 
(Adapted from (Walck-Shannon et al., 2016; Walck-Shannon et al., 2015)

Introduction: One of the difficulties in analyzing dorsal intercalation has been that is 

occurs at a time in C. elegans development during which there is substantial overlap between 

maternal and zygotic expression of gene products. Moreover, it has been difficult to express 

constitutively active and dominant negative constructs that are standard in other system for 

analyzing the roles of Rho family GTPases. Others have developed degron-based approaches 

that lead to tissue- or temporal-specific loss of specific proteins (Armenti et al., 2014; 

Ashley et al., 2021; Wang et al., 2017). Here we review the use of a complementary system 

that allows smg-dependent inducible temporal- and tissue-specific expression of Rho family 

GTPases.

MATERIALS—Nonsense-mediated decay (NMD) conditional expression system strains: 

The details of these strains can be found in (Walck-Shannon et al., 2016; Walck-Shannon et 

al., 2015). Briefly, transgenic strains were produced in which specific mutant Rho GTPase 

family gene coding regions were cloned behind the lin-26 promoter, which drives the 

constructs in the epidermis. The constructs contain a NMD-sensitive 3ʹUTR sequence (an 

inverted let-858 coding sequence without a sense polyadenylation sequence) designed by 

one of us (DR). The mRNAs transcribed from these clones only persist in the absence of 

the NMD surveillance system. This is achieved using a smg- 1(cc546ts) background. At the 

restrictive temperature (25°C) NMD does not occur, allowing the relevant mRNA and hence 

protein to accumulate (Figure 10A).

Positive control strain: A control stain that expresses a Plin-26-driven nuclear-localized GFP 

can be used to troubleshoot the system (Figure 10B).

METHOD

1. Induction using the NMD system: Strains should be maintained at 15°C unless 

induced, including during crosses. To induce the conditional expression system, 

incubate mothers at 25°C for 24 hours prior to harvesting embryos in a 

convection incubator.
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2. Confirming efficacy of induction: ImageJ can be used to measure the total GFP 

signal per embryo. Induced embryos should express GFP robustly, whereas as 

uninduced controls should not (Figure 11B).

3. Filming: Standard agar mounts can be used for filming. Embryos of both 

induced and uninduced groups should be filmed at 20°C using the same settings. 

Examples of phenotypes induced by NMD-inducible expression are shown in 

Figure 9.

4. 4.

E. Laser killing of blastomeres in Caenorhabditis elegans (adapted from (Walston and 
Hardin, 2010))

Introduction: Blastomere isolation and recombination experiments have led to a wealth of 

understanding of early embryonic events in the Caenorhabditis elegans embryo. However, 

isolated cells do not generate dorsal epidermis that is capable of morphogenesis. An 

alternative approach to studying cell autonomy during dorsal intercalation is to use laser 

killing/laser ablation of individual cells. Laser killing can be used to kill one of two cells 

in contact with each other to understand what results the neighbor no longer can transmit a 

signal. Additionally, killing a cell that is between two cells that will eventually contact each 

other can result in the corpse of the cell forming a steric barrier between the cells preventing 

the contact. The following protocol describes laser killing of embryos mounted on an agar 

mount.

IMAGING SETUP—The laser killing of C. elegans blastomeres requires DIC optics with 

an approximately 60–100x, high NA objective lens. The microscope also requires a tunable 

dye laser attachment for the lasing and a camera to observe progress of laser killing. (see 

above under Introducing Pharmacological Agents)

MATERIALS

Reagents

C. elegans embryos mounted on an agar mount slide

M9 buffer

3 g KH2PO4

6 g Na2HPO4

5 g NaCl

1 mL 1 M MgSO4

1 L H2O

VALAP

Equal parts by volume of Vaseline, lanolin, and paraffin.

Heat thoroughly until melted and mix.
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METHOD

1. Prepare embryos on an agar mount (see above under “Agar mount…”)

2. Place embryos on microscope and locate on slide.

3. Focus image on top focal plane of embryos.

4. Move focus slightly above the embryos (essentially focusing on the cover slip of 

the slide) and move microscope stage to remove embryos from the field of view.

5. Activate single pulse of the laser. If focused properly, the laser should crack or 

poke a small hole in the cover slip when pulsed.

6. Note on the monitor where the pulse cracked the cover slip.

If using a monitor with a glass screen, marking the spot on the screen with a 

marker directly on the screen is convenient.

7. Move microscope stage back to embryos and focus on the nucleus of the 

blastomere to be targeted.

The target nuclei should be in interphase of the cell cycle and should not be 

undergoing division.

8. Lase nucleus of target cell with approximately 10 pulses per second until 

“charcoal” build-up can begin to be seen within the nuclei, approximately 10–15 

seconds.

9. Record embryonic development with 4D microscopy. Examples of this approach 

using Nomarski and disk scanning confocal microscopy are shown in Figure 11.

TROUBLESHOOTING

Problem: No hole or crack appears in cover slip when targeting laser.

Solution: If no hole appears in the field of view, either the laser is not aimed properly 

down the objective within the field of view or the focus is incorrect. The microscope 

must be focused on the cover slip. If the laser is properly positioned, slightly adjust 

the focus with the fine focus until the cover slip is in focus.

Problem: Embryo explodes when laser killing is attempted.

Solution: If focused too close to the cover slip while targeting the nuclei within a 

particular embryo, the embryo will rupture as the laser cracks the cover slip. To 

prevent this, target focal planes of that nuclei deeper within the embryo.

Problem: Cell fails to die and continues through development.

Solution: If the target nucleus is not lased sufficiently, it can recover and the cell 

will resume mitotic divisions while the embryo progresses through development. 

Additionally, some cells progress through one final cell division prior to halting any 

future divisions. Depending on the particular nature and goals of the experiment, 

this may or may not be acceptable and the cell should not be considered killed until 

cell divisions are halted. Many laser-killed blastomeres will display Brownian motion 
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within the cytoplasm following ablation and this should not be confused with cell 

division.

Problem: The entire embryo dies rather than killing an individual blastomere.

Solution: Contrary to the previous problem of not lasing the nucleus long enough, 

if the entire embryo dies, it is usually due to excessive lasing triggering embryonic 

arrest. Practice and experience will provide the best experience with gauging the 

appropriate amount of lasing to trigger cell death without killing the entire embryo.

DISCUSSION—Laser killing of blastomeres is a classical approach to studying cell 

autonomy in the dorsal epidermis and has revealed that the posterior dorsal epidermis is 

surprising autonomous in its ability to intercalate. While the cell carcasses that remain after 

ablation can complicate interpretation, the difficult of isolating tissues via microsurgery in 

C. elegans makes laser killing a useful addition to other technologies.

III. Summary

C. elegans is a powerful system for studying cell intercalation that combines simplicity, 

transparency, and ease of genetic manipulation. Both classic technologies (laser ablation, 

phalloidin staining) and high-resolution live imaging using genetically encoded reporters are 

continuing to yield insights into the deceptively simple process of dorsal intercalation of the 

embryonic epidermis. The advent of genome editing, degron- and NMD-inducible strains, 

optogenetic tools, and other modern technologies promise to make this simply model system 

an even more powerful system for delineating the basic cellular repertoire of intercalation.
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Figure 1. DIC images of dorsal intercalation in a wild-type C. elegans embryo (dorsal view).
Right nucleus, black asterisk; left nucleus, white asterisk. (Bottom) Corresponding cartoon. 

The box indicates the posterior, C-derived dorsal epidermal cells colorized in the top panel. 

Anterior (A) is to the left, posterior (P) to the right; right and left cells are pseudocolored in 

blue and green, respectively. From Walck-Shannon et al (2015). Scale bar, 10 μm.
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Figure 2. The Micro-Manager interface.
(A) The main Micro-Manager window. (B) The Multi-D Acquisition panel. (C) A 21-focal 

plane Nomarski 4D movie being acquired.
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Figure 3. Making a standard agar mount.
(A, B) Gravid hermaphrodites are cut in half with 27-gauge ½” needles. (C) At a higher 

magnification, embryos are sorted and grouped using an eyelash. (D) Embryos and M9 

buffer are transferred using a mouth pipette. (E) Three slides are placed on the bench and 

the outer two are taped down to the bench. (F) A drop of molten 5% agar is placed onto 

the middle slide. A fourth slide is then placed perpendicular to the three original slides. The 

top slide is compressed over the taped slides. (G) The finished slide is sealed with VALAP. 

Using a toothpick to make hash marks in the VALAP (arrows) aids in finding the grouping 

of embryos on the compound microscope. (H) A low- magnification view of embryos within 

a completed mount. Embryos are grouped tightly together (image courtesy of T. Loveless).
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Figure 4. Pseudocoloring Nomarski datasets in ImageJ.
Top: The ROI Manager can be used to set properties of regions of interest that have been 

traced using the freehand or polygon selection tools. Bottom: a finished overlay placed 

side-by-side with the unlabeled dataset by combining stacks (see the text).
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Figure 5. Using genetically encoded junctional markers to visualize dorsal intercalation.
A-C: A schematic (A), and comparably staged embryos imaged using Nomarski microscopy 

(B) and multiphoton excitation microscopy to visualize dlg-1::gfp expression. (C) during 

mid-intercalation. D-F: Late intercalation. C and F are Z projections of 9 focal planes spaced 

1 μm apart. Scale bar = 10 μm.
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Figure 6. Visualizing F-actin during dorsal intercalation using VAB-10(ABD)::GFP.
Top: Mosaic expression of an epidermal-specific F-actin reporter [Plin-26::vab-10(actin 
binding domain)::gfp] reveals dynamic protrusions during intercalation (dorsal view). 

Initially, small protrusions can be seen along the medial edge (green asterisks) and at 

positions lateral to the leading edge (yellow arrows), but the latter are eventually withdrawn 

as intercalation proceeds. Bottom: Protrusions in wild-type (WT) cells become medially 

polarized as intercalation proceeds. (B) Rose plots of the angle of protrusion relative to 

the cell centroid early (prior to and during wedging, left) and late (during tip and cell 

body extension, right). Red bar denotes the circular mean and deviation (Mardia-Watson-

Wheeler). Scale bar, 5 μm.
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Figure 7. Using cytoplasmic FPs to visualize dorsal intercalation.
Arrows indicate fine protrusions. (A) Frames from 4D movies of dorsal intercalation in an 

embryo expressing Plbp-1::gfp, which is expressed in a subset of dorsal epidermal cells, 

imaged using multiphoton excitation microscopy (Heid et al., 2001) using a Ti:Sapphire 

laser and descanning through a Bio-Rad 1024 scanhead. z-stacks were subsequently 3D 

projected using a maximum brightness procedure. (B) A similar embryo imaged using 

disk-scanning microscopy (Yokogawa CSU-10 scanhead, Hamamatsu Orca-IIER camera). 

The dataset in (B) was subsequently subjected to surface rendering using Volocity software. 

Fine protrusions make contact with a non-dorsal (seam) cell (asterisk). (C) Plat-1::gfp 
imaged using an Andor DragonFly 500 spinning disk scanhead and an Andor Zyla camera. 

Extremely thin protrusions are visible (arrows). Scale bar = 10 μm.
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Figure 8. Localization of a CDC-42 biosensor (GFP::WSP-1(G-protein binding domain[GBD])) 
during dorsal intercalation.
Micrographs were pseudocolored according to fluorescence intensity using the “Fire” 

lookup table in ImageJ. As the medial edge becomes pointed, it accumulates active CDC-42 

(white arrows), which is maintained during intercalation. Scale bar = 5 μm.
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Figure 9. Common phenotypes in the dorsal epidermis.
For details on the NMD-inducible system, see the text and Figure 10. Top: Normal 

intercalation in an NMD negative control. Middle: Expression of a constitutively active 

ced-10/Rac construct results in comigration, as two blue cells migrate together, disrupting 

the normal strictly alternating pattern of [posterior dorsal cells. Bottom: Expression of a 

dominant-negative ced-10 construct results in staling at the dorsal midline and delayed or 

failed intercalation. Adapted from Walck-Shannon (2015).
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Figure 10. NMD-mediated inducible gene expression.
(A). Scheme for transgenic tissue-specific, conditional expression of transcripts in C. 
elegans. At the permissive temperature (15°C), smg-mediated surveillance results in 

degradation of transcripts. At the restrictive temperature, the smg-system is inoperative, 

allow perdurance of transcripts with the smgsensitive 3’-UTR. (B) Control strain for 

assessing induction. Nuclear GFP expression indicates induction. No GFP is visible when 

embryos are reared at the permissive temperature (15°C). Scale bar = 10 μm. From Walck-

Shannon et al (2015).
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Figure 11. Using laser ablation to study cell autonomy during intercalation.
(A) AB was ablated in an embryo expressing AJM-1::GFP. The C-derived dorsal 

epidermal array (middle and right, arrows) underwent intercalation. (B) EMS was ablated. 

Color overlay indicates that intercalation occurs essentially normally. These and similar 

experiments indicate that intercalation is a process largely autonomous to the dorsal 

epidermis. Scale bar = 10 μm.
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